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If you work with both your browser (Internet Explorer) and the spreadsheet file (xlsx) open at the 
same time, you might find it easier to follow the instructions. If you are not comfortable doing this, 
just print out the Web file and use it off of paper.  

 

Excel 2010 - Part I: Getting Started 

 

I. Introduction  

What is Microsoft Excel 2010? 

Microsoft Excel is a spreadsheet program. The version covered in this tutorial is Excel 2010. Excel 
2010 is slightly different than Excel 2007 and quite different than Excel 2003. The function of a 
spreadsheet is to store and manipulate data, in particular numerical data. Once this is done, this 
data can be output in various useful forms such as tables and graphs. Though originally made for 
economics and business, spreadsheets are now widely used in scientific and engineering 
applications.  

Why is spreadsheeting important to you? 

As computer programs go, spreadsheets are not particularly fast number crunchers, and the 
programming you can do with them tends to be fairly elementary. However, when dealing with 
computers a large part of your time is spent not on crunching numbers or programming, but on 
formatting your output. This is where spreadsheets work particularly well. They are capable of taking 
your data, performing mathematical manipulations, and making a clear presentation of the data in 
graphical form. Thus, they provide a convenient method for analyzing all types of data (financial, 
inventory, laboratory, etc...) and producing high quality graphics. In addition, if you desire, you are 
able to make a 'quick and dirty' graph to check on the data input, the quality of data, and the strength 
of your mathematical relationship.  

You will find that spreadsheets are often used in the Navy. As a JO, you might find that you are 
called upon to use a spreadsheet for training records, inventories or as a division officer's notebook. 
Those of you who are exploring engineering careers might find this as a frequently used tool. 

EXERCISE 1 : Starting the Program 

The first step in learning to use your new software is to start the Excel Program. You launch Excel 
by 1) SELECTING the Windows Start button; this will bring up a set of choices in a menu. 2) Drag 
your cursor over, All Programs. Another menu will appear to the right. 3) Drag your cursor over to 
Microsoft Office 2010 and SELECT Microsoft Excel 2010. 

Note that each file made by Excel 2010 has the extension .xlsx while each file made by Excel 2003 

 



has the extension .xls.   While Excel 2003 is now uncommon, you may need to save your Excel files 
in 2003 format if you will be sharing it with a person who still has Excel 2003 (for example your 
instructor).   In this tutorial, we will describe files, as 'xls files' even though you may be saving them 
as ‘xlsx files’. 

The initial xls window may not fill your whole screen. This size is very useful if you want to use more 
than one application simultaneously (such as a Web Browser), however, often, it is desirable to have 
a larger working window (also called working environment) in Microsoft Excel.  

The size of the working window is controlled by two sets of three small buttons on the top right of the 
window (circled with red and yellow). The ones on top (the Title Bar) control the whole Microsoft 
Excel program environment and the ones on the line that starts on the far left with File (the Menu 
Bar) control the environment of the particular xls file. If you have more than one file up at a time, 
each will have these three buttons on their own File Title Bar. 

 

 

The left-most looks like an underline symbol. If you click on the box, the program/file gets small. This 
is called minimizing. From the Title Bar, the underline symbol minimizes the program to the Task Bar 
on the bottom of the screen. The name of the task always resides there even while the program is 
large. You will see it as the name of the program (Microsoft Excel) and a shortened version of the 
file name. When minimized, by SELECTING this Task, it will return the xls back to its previous size. 
This is called maximizing. Try minimizing, then maximizing the program.  

If you minimize the file by SELECTING the underline on the second line (or the File Title Bar), this 
minimizes the file to a Task Bar within the Microsoft Excel program, this time as just a shortened 
version of the file name. Try minimizing, then maximizing the file.  

The center symbol is either a square with a heavy line on the top of the box or two smaller 
overlapping versions of this box. If the single box shows, SELECTING it will make the environment 
larger. If the two boxes show, SELECTING it will make the environment smaller. It is a toggle; give it 



a try back and forth.  

If you were to SELECT the 'X' on the right, the program would close. It is unnecessary to try this one 
right now. If your file has been changed since it was last saved, it will ask you if you wish to save the 
changes. If you have saved it or have not done anything to the file, it will close the program 
immediately. 

Exercise 2: Entering Information 

The following is data from an experiment performed to examine how the pressure of an automobile 
tire changes as a function of the temperature of the tire. Type the Data into your spreadsheet as 
shown. 

 

Part A 

Each spreadsheet program creates a 'Book' which is made of a number of 'Sheets'. The default has 
Sheet 1 - Sheet 3 available. You will be inputting data into what are called cells. Cells are addresses 
for information. In a spreadsheet book these address are defined by three parameters: 1) the sheet, 
2) the column and 3) the row. When you open a new spreadsheet, it will default to Sheet 1, cell 
column A, cell row 1. In the image above, the cell D1 is boxed and is identified by its address just 
above the spreadsheet on the left. The book is on Sheet 1 (you can see the button sheet 1 
highlighted on the bottom). There is a spreadsheet on each of the three sheets. Each spreadsheet 
has unlimited columns and rows, and though currently there are only three sheets, as many as you 
want can be added.  

In these exercises, we will be working on only sheet 1. Assume that all cell address refer to this 
page. First, we will create labels in order to make your spreadsheet easy to interpret. SELECT the 
appropriate cell using your mouse and type in the labels 

If you are within a cell, if you just start typing and the label will appear in the cell. It will not record 



what you type until you tell it you are done. You can do this by 1) SELECTING another cell with your 
mouse. 2) You can hit the 'Enter' key on your keyboard. It will records what you have typed, and will 
move you to the cell just below in the same column. 3) Hitting an arrow key will record and move you 
to the corresponding active cell. If you type "Tire Pressure vs. Temperature" into cell A1 then hit the 
'Enter' key, you will be all ready to type "Pressure (psi)" into cell A2.  

Cell Label 

A1 Tire Pressure vs. Temperature 

A2 Pressure (psi) 

B2 Temperature (degrees Fahrenheit) 

Note that some labels appear to extend over more than one cell. Navigate to cell B1 by SELECTING 
it with your mouse or using the arrows on your keyboard. Try entering your alpha code into B1. You 
will notice the remaining digits overwrite the A1 entry in the spreadsheet area.  You may wonder if 
your typing into cell B1 has erased some of cell A1. Arrow over to A1. You will notice that the whole 
text of the label shows again. You never lost it; it was just hidden on the spreadsheet window by cell 
B1. If you move back to B1 and press the Del key, the alpha code will be removed. As cell B1 is 
again empty, the full contents of cell A1 will reappear in the window. 

Part B 

Place the pressure data in the A column starting at cell A3. Remember, you can record the data and 
move down, both, by the 'Enter' key. Place the temperature data in the B column starting at cell B3.  

Exercise 3: Formatting 

Note that the trailing zeros have been dropped from some of the data entries. In order to show these 
zeros your will need to change the numeric format of the data blocks.  

Part A 

Highlight the block of data from A3 to A8 by placing the mouse cursor on A3. Hold down the left 
mouse button and DRAG the cursor down to A8. The block of data should now be highlighted. 

Part B 

Under the Home tab to the far left, you will find “Cells”.  Within Cells, go to the Format function.  As 
shown below, a menu drops down, and at the bottom of that menu is Format Cells. The window 
that pops up is titled Format Cells. Since you have highlighted the set of cells from A3 to A8, 
inclusive, on sheet 1, the changes you make will only affect these cells.  The other way to get to this 
menu is to highlight the entries hold your cursor over the highlighted block and click the RIGHT 
mouse button. A menu should appear. This is the Object Menu. Contained in this menu is "Format 
Cells". SELECT this and off you go to the same Format Cells menu.  



 

Part C 

The Format Cells window has six folders with a menu on each. Each of the folders is labeled with a 
tab at the top. Number is the top or left-most folder. In this folder there is a list of categories. 
SELECT "Number" from this list. This will allow you to set the number of decimal places in your data. 
You will notice in the upper right of the Sample preview box is 32.00. We wish to have one place 
after the decimal, so change the value of decimal places to 1 in the box that comes up towards the 
top on the right. This can be done by typing 1 in or hitting the down arrow to get to 1. The preview 
box should now display 32.0(see below). 

 



 

 

Part D 

SELECT the OK button on the Format Cells menu to return to the main spreadsheet. The entries 
32.0 and 36.0 are now properly displayed. Any value which is entered into this block will be 
displayed with one digit beyond the decimal point. This may seem an esoteric example in changing 
a format, but for a chemist, we are now satisfied that all of our pressures have the same number of 
significant figures after the decimal point.  

Exercise 4: Saving a Spreadsheet  

SELECT the file menu from the top left corner on the Toolbar. Select Save or Save As in the menu 
that appears. You will arrive at the same menu if you choose the Save or Save AS. Now, choose the 
Save As commands.  

At the top it (most likely) will have: Save File. SELECT the box on the left labeled Desktop. Then 
SELECT the icon on the top (a yellow folder). This allows you to create a new folder. At the top give 
the folder the name Chem. Then at the bottom of this window enter the file name as "tutor1" and 
SELECT Save This is the working title for your spreadsheet book. Always change this title to 
something that will help you to remember what you were working on.  



Note that the Notebook Title Bar (at the top of the Microsoft Excel window) indicates the filename 
along with the .xlsx extension which identifies it as an Excel 2010 file. 

Exercise 5: Finding Your File 

(a) If you have used the file recently, the quickest way to retrieve it is to go through File: Recent 
Documents. However, Windows will not allow too many files to accumulate in Recent Documents, 
and will purge address after a while. What 'a while' means is dependent upon usage. 

SELECT the Windows Start icon. Select My Recent Documents and you should find tutor1. 

(b) At the top left of the Windows environment is an icon titled My Computer. If you Double-click this 
(SELECTING twice the same icon in quick succession) you will find, among others, (C:). You will 
find the folder Chem in the window that comes up, and double-clicking on it will reveal the contents. 
You should find tutor1. 

(c) A final method of finding your file is to go to Windows Start. Go up to Programs over to 
Windows Explorer, within (C:), you will find the folder Chem in the left-hand window. Double-
clicking Chem , will bring up in the right-hand window that directory's contents. You should find 
tutor1.  

Exercise 6: Closing and Opening a File 

There are two common methods to close a file. In the course of closing the program, any file you 
have open will be closed. Or you can close a file without closing the program. These two actions are 
represented by the two X's in the upper right corner. The X in the very top right (in the Title Bar) will 
close the program, Microsoft Excel. If you have not saved the file since you have made any 
changes, it will ask you if you wish to save the file. The other X (in the Menu Bar or the File Title Bar) 
will close the file, but not the program. It will prompt you to save the file you have been working on. 

Opening your file uses the same methods as finding the file. We can do this because Windows 
recognizes that any file with the extension .xlsx is a Microsoft Excel 2010 file. If we choose a .xlsx 
file, be it from Documents, My Computer or Windows Explorer, Windows will recognize that it is 
associated with Microsoft Excel. It will launch the program while opening the file.  

Exercise 7: Turning a Data entry into a Graph in Microsoft Excel  

There are two types of variables in a process. Independent and Dependent. The independent 
variable is the variable that is put on the X axis. In this case temperature is your independent 
variable. The dependent variable is placed on the Y axis. In this case pressure is your dependent 
variable.  

Caution #1: Beware:  Microsoft Excel 2010 has a decided preference for having Independent /X-
data (that is data that will be plotted along the x-axis) to the left of the Dependent/Y-data.  So even 
though one says, Y vs. X (in our case Pressure vs. Temperature), Excel 2010 gets fussy unless you 
input your data X to the left, Y to the right, in our case Temperature to the left and Pressure to the 
right.  So we are going to use this opportunity to have you move the data and headings.   

SELECT A2:A8.  There will be a thick-lined box around the data.  Move your cursor over the thick 
line and crossed double-arrows will appear.  If you SELECT at this point, you will be selecting the 



whole range, not just one cell.  As you move your cursor, the whole range will move, so set this data 
off to the right side, for example in the D column.  SELECT B2:B8, grab it by putting your cursor over 
the edge and drag it to the A column and drop it there by releasing the mouse button.  Now take the 
Pressure data which you put in the D column, and move it to the B column.  Excel 2010 may be 
unaware of its blissful state, but it is now blissfully unaware that it is ready to graph.   

SELECT datain A3:B8. This takes care of both the X-axis data (in the column to the left) and the Y-
axis data (in the column to the right).  Just to the right of the Home tab, SELECT the Insert tab at 
the top of the xls window and click the Down Arrow underneath any of the chart icons (column, line, 
etc). Then click All Chart types. Now you are in the Chart Wizard Window (see below). This 
window allows you to chart your data.  

Step 1: For this particular set of data we want an XY chart. SELECT the chart XY(scatter) from the 
menu. Select the one with points only, do not pick the one with lines. We can add lines at a later 
date. 

Caution #2: Beware: the default Chart Type is NOT what we want. We want an XY Chart.  

 

You should immediately see a chart pop up. The chart should look like what you see below. 



 

To alter the chart you must first left click on the chart. Once that is done find the Select Data option 
on the top toolbar. From this option you can change your data ranges or change your series using 
the Edit menu.  You know all that hassle we went to to keep the X-axis on the left?  We could have 
changed it all in this Edit menu, but we will leave that method to you to figure out in your idle 
moments. 

A series is a set of data that corresponds to other data with it. For example you have two series of 
data in this example. The first is your temperature series which is A3 to A8. The second is your 
pressure series which is B3 to B8.  At the moment, you have only the pressure data selected.  To 
SELECT temperature data as well, go to Select Data, then SELECT Add Series. 

Exercise 8: Modifying a Graph 

Excel gives you the opportunity to set your own graph size rather than insisting that you use their 
defaults. The scale on this graph is a little clumsy, the y-axis starting at 31 and ending at 39. Starting 
at 30 and going up by 2's to 40 would give a more pleasing look. As spreadsheets are all about ease 
of formatting, we might as well make the graph look good. We can adjust the attributes of the Y-axis 
and, later, the X-axis by calling up a window for each. We call up the Y-axis window by putting our 
cursor over the numbers along the Y-axis in the graph and clicking on the right button on the mouse. 
You will get a drop-down menu with "Format axis" at the bottom. 



 

SELECT Format Axis. A window will come up with a number of options (see below circled in red). 
SELECT the Axis options tab. To change the minimum, first SELECT the Fixed (for “fixed axis” as 
opposed to an axis automatically chosen by the program), then change from 31 to 30.  In the same 
manner, change the maximum from 39 to 40, and the major and minor units to 2 (area circled in 
blue). SELECT Close.  

In the same way, move your cursor over the numbers on the X-axis and right-click. SELECT "Format 
axis" and modify the minimum to 25 (remember to SELECT Fixed), the maximum to 250, and the 
major and minor units to 25. SELECT Closed. 

 



 

The final graph with no line and the modified X-axis and Y-axis scales should look like:  



 

Exercise 9: Printing 

If you want to save your printer cartridge a bit, you can take away the background shading in the plot 
area. Having shading does look pleasant and you can make quite a number of effects, but it is a 
cartridge killer. To remove the background shading, right click on the background and a menu will 
come up. SELECT the Format Chart Area option and a window will come up. On the right side is 
Area. Change it from Automatic to No Fill. 

To print the graph and spreadsheet data, highlight the spreadsheet data and the cells behind the 
graph. If you print this now, it will print both the spreadsheet and the graph. The easiest way to 
access the Print window is to use the downward triangle on the top left corner of the window. Click 
the triangle, and then click Print Preview and Print.  

If you want to fit your graph and spreadsheet onto one printed page, in the Print window, select the 
Scaling tab and select Fit Sheet to One Page.  This will force your output to one page.  Sometimes 
you may have to change the orientation (Landscape vs. Portrait), margins, or scaling to ensure the 
printout is legible.   



 

When you are ready to print, press the Magnifying Glass icon and print your document. 



 

 

A Print window will appear. For our purposes, you can SELECT the Print command. If you printer is 
properly installed, on and functioning, you will get a printout. You can play with these and other parts 
of the Print window at your leisure. 

This is the end of this Quick Start. You may want to save your file and exit Microsoft Excel.  

 



This page was last revised on 23 Aug 2010. 

If you have any problems or questions about the program, contact Joseph F. Lomax.  
 
 


